1. YcTaHoBKa Eclipse n nnarnMHa TeKCTOBOM aHa/IMTUKM
Mpoueaypa cKauymMBaHMA N YCTAaHOBKK cpeabl pa3paboTku Eclipse n nnarnMHa TeKCTOBOM aHa/IMTUKKU ONKUCAHa B:

http://synthesis.ipi.ac.ru/synthesis/student/BigData/seminar-hadoop/lectures2014/06 MapReduce Lab.pdf

B KauecTBe cepBepa 6yayT MCNONb30BATLCA TE e CamMble AaHHble YTO M NPOLWAbIA pas:


http://synthesis.ipi.ac.ru/synthesis/student/BigData/seminar-information-extraction/

2. Co3gaHue nNpoekTa
BbibpaTb: File -> New -> Biglnsight Project

BeecTn uma npoekTa.

i N
78] New Biglnsights Project SR

Biginsights Froject
Create a new Biglnsights project.

Project name:  RegularExpressions]
Use default location
Location: | Dx\Users\Dima\workspace\RegularExpressions Browse...

Choose file system: | default

@ <Back | Net> || Finsh || Cancel

e

Co3pnaHue ampekTopum data
KNMKHYTb NpaBoi KHOMKOM MbILWW Ha Ha3BaHMe NPOEKTA B 3aKknaake Project Explorer.

BbibpaTtb New -> Folder

BeecTv umsa gupeKktopum data.



E MNew Folder |. El é

Folder —

Create a new folder resource, ,._f ,_f

Enter or select the parent folder:

M5U_RegularExpressions

o
ﬁ HiveScript -
::5 laglScript
ﬁ JaglTestl —
=5 MSU_RegularExpressions
l_%‘ PigSeript
1= Servers
{3_1,-\{ SimilarDecumentsl
E'é Test
é Test2
{:5 Test3
::5 TextAnalytics
= TextAnalyticsTest 4

m

Folder name: data|

@j Finish l [ Cancel

NmnopT AaHHbIX
CkayvaTb dain Facts.txt http://synthesis.ipi.ac.ru/synthesis/student/BigData/lectures-ie/Facts.txt

KAMKHYTb NpaBo KHOMKOM MbllLK Ha aupeKkToputo data B 3aknaake Project Explorer.
BbibpaTb Import
BbibpaTb General -> File System

YKaszaTb ANPEKTOPUIO, rae coxpaHuam dain, BeibpaTtb 3TOT daiin u HaxKaTb Finish.


http://synthesis.ipi.ac.ru/synthesis/student/BigData/lectures-ie/Facts.txt

BigInsights - ExtractCountries/FindCountries.aql - Eclipse

Eile Edit Navigate Search Project Bun Window Help
. 1 1 1 1
J i J S New >
Go Into
Show In Shift+Alt+W »
= & ExtractCountr Copy Ctrl+C
P =i Biginsights | E2 Copy Qualified Name
P =k JRE System [ Paste Ctrl+V
P #Fsrc K Delete Delete
= result
7 FindCountri Build Path G
Refactor Shift+Alt+T *

=5 Biginsights Se &%
B

# Biginsights Se

g Export...

£ Refresh

Close Project

Validate
Bun As
Debug As
Profile As
Team

Compare With

Restore from Local Historx...

Source

Labeled Document Collection

Properties

:# Open Extraction Plan

F5

Alt+Enter

J 0¢ =4 Extra
Qe &
&  Import
Select

Import resources from the local file system into an

existing project.

Select an import source:

= = General

P =cCvs

h

[E Archive File

= Existing Projects into Workspace

B File System

El Preferences

@ |

]|| Next > H

[ canca




£ | Import
File system

Import resources from the local file system.

o x

From directory: |/home/labfiles

[ {7 employee csv

B Facts.txt

[ [5 publisher
[ |5 Twitter Search json

[Hlter;rypes...] [ Select Al ] Igese{ectAll

Into folder: [ExtractCountries ] [ Browse...

Options

[] Qverwrite existing resources without warning

(0 Create complete folder structure

(3 Create selected folders only
@ [ < Back “ || Ermsn | [ Cancel

Co3paHune AQL darina
Cospatb AQL moaynb main
e Bbi6paTsb: File -> New -> AQL Module
e Bectn umsa moaynsa
i '1
) New AQL Module o B
AQL Module —

Usze this wizard to create a new ACQL module | J
Project: [TestSentiments Browse
Module name:  main
@ Finsh | [ Cancel




Cosagatb AQL dainn main.aql

e BbibpaTb: File -> New -> AQL Script
e BbibpaTb MogyAb Main
e Bsectn uma daina main.aq|

rﬂ MNew AQL script l | =] |_ihr
AQL script —

Use this wizard to create a new ACQL script s
Project: /MSU_RegularExpressions Browse
Module name:  main Browse
File name: main.aq|

@:‘ Mext = Einish l [ Cancel

CozpnaHue npeacrasaeHmna Countries
OTKpbITb dpaiin main.aql

BeecTu:

module main;

create view Countries as

extract regex /Geography {1,}([A-Z]1[a-z]1{1.} ?[A-Z]*[a-z]*)/ on D.text
return group 1 as country

from Document D;

output view Countries;

[na pefakTMpoBaHUA PerynsipHbIX BbiPaXKeHMI MOXKHO BOCNO/1b30BaTbCA KOHCTPYKTOPOM PerynspHbixX
BblpParKeHUM:



r@ Regular Expression Builder — - lgléu

Regular Expression Builder

Create a rule by selecting censtructs and combining them. You can also specify a regular expression by typing into the text box. When you are done, enter text to test your rule.

Select a construct to add it to the current regular expression rule

Characters | Construct Matches
Character class -
racter classes The backslash character
Predefined character classes
|| | Boundary Matchers The tab character £
Greedy quantifiers
Logical operators [ W I The newline (line feed) character
Match Flags

The carriage-return character

Specify a regular expression rule.

Geography {1, /[A-ZI[a-zl{L,} A-Z[a-z)%) -
Type the text that you want to use to test the rule: Matched:
Geography Afghanistan 1| Text Start Stop  Sub-pattern
Geography United Kingdom 5
Geography Afghanistan 0 pal 1: [Afghanistan]
Geography United Kin.., 23 47 1: [United Kingdom]

®@ [ mnish ][ cancel

KoHburypaums BbinoaHeHMA
BbibpaTb meHto Run -> Run Configurations

”

BigInsights - ExtractCountries/FindCountries.aql - Eclipse

File Edit Mavigate Search Eruject-ﬂinduw Help

Bun Ctri+F11
Jr*jv JﬁvquvJ@%—
. . Debug F11
ﬁﬁi ﬁ i £ Pacﬂ = 8 [4. Bigin
] Run History r
& = --
= Run As »
¥ =¥ ExtractCountries Run Configurations. ..
I» = Biginsights V1.3
b Debug History L
RE System Library []
) v v Debug As r
b @src Debug Configurations. ..
= result
Facts txt L, External Tools v
¥ FindCountries.aq|

KAMKHYTb NpaBoi KHOMKOM MbiwK Ha Text Analytics 1 BbibpaTb New




# _ Run Configurations

Create, manage, and

run configurations

Run Text Analytics Application

®

—+l
-
S

¥ =

12l JaqL
i Java Applet
3] Java Application

@f Java MapReduce

Configure launch settings from this dialog:

- Press the "New' button to create a configuration of the selected type.

¥ - Press the 'Delete’ button to remove the selected configuration.
= - Press the 'Filter' button to configure filtering options.

- Press the 'Duplicate’ button to copy the selected configuration.

- Edit or view an existing configuration by selecting it.

Filter matched 7 of

Ju JUnit
Juj Task Context Test| Configure launch perspective settings from the Perspectives
Cam ot —prafarence page.

[ New

@

||

Close

BbibpaTb npoekT, AQL moaynb main, ykasaTb ANPEKTOPUIO C Ppaliiom AaHHbIX Facts.txt

-
T8} Run Configurations %

S

Run Text Analytics Application

Create, manage, and run configurations

B X|E 3%
| type filter text |

B HTTP Preview
[ J2EE Preview
78 JAQL
15 Jagl Test
T# Jagl Test2
EGl Java Applet
[T Java Application
&% Java MapReduce
Ju JUnit
ﬁ JUnit Plug-in Test
m2 Maven Build
[B] MWE Workflow
[F Mwe2 Launch
4 05Gi Framewaork
&, Pattern Discovery
&% Pig
Juj Task Context Test
B Text Analytics
¥ New_configuratic
¥ | Mew_configurati(

m

® 1 SimilarDocumend
B Test
B Test2

>3 K5

L F—T—

3

Filter matched 33 of 33 items

Nare: MSU_RegularExpressions

|25 External Tableq [EL, External Dictionarieﬂ

=] Main

Project: MSU_RegularExpressions

Select modules

Language of input decument collection @

Location for the input document collection

/MSU_RegularExpressions/data

Browse Wulkspace] [ Browse File Sys‘(eml

J

Revert ]

@

Close ]

HaxkaTb Apply

Pe3ynbTaT BbINOJAHEHWNA SKCTPAKTOPOB
B KOHOUIypauum BbINOAHEHUS HaxKaTb Run

lNocne BbINOAHEHNA OTKPOETCA CTPaHMLA C pe3y/ibTaTaMu:




-
E Biglnsights - \Facts.bxt - Document.text - Eclipse

m@g

L Axis2WSTest

f'pi Axis2WSTestClient
= HiveSeript

=5 JaglScript

72 JaqiTestl

[ src

&=~ data
Facts.tut

= result

= textAnalytics
= bin
iy sre

& main

4 I

& MS5U_RegularExpressions
=), JRE System Library [jr
=i, Biglnsights ¥2.0.0.0

-

m

,\\‘, main.agl T

»

Location:

Area:

Geographic coordinates:

Map references:

LArea - comparative:

i Geographv Afghanistan

Southern Asia,

Lsia

north and west of Pakistan,

33 00 H, 65 00 E

2lightly smaller than Texas

east of Iran

total: 647,500 sg km water: O 3g km land: 647,500 s3g km

a crumbling infrastructure,

File Edit MNavigate Search Project Run  Window Help
-G E H-0-Q- OG- @S- HY  HLEEE Ef [ & Biglnsights ”
W] v ql v Ep o ow - & Biglnsights T...
I-—[\ﬁ Proj &2 [% pack| — O Task Launcher for Big Da \\,l, rmain.agl Facts.bt = \Facts.txt - Documenttex 22 =B ﬂEHe E, WFOED =08
J] g q
= <'===D| & = government structure that resulted in the inauguration of Hamid KARZAT =~ a @ - @ L ==

as Chairman of the Afghan Interim Authority (ATIA) on 22 December 2001. D
In addition to occasionally violent political jockeying and ongoing
military action to root out remaining terrorists and Taliban elements,
the country suffers from enormous poverty,
and widespread land mines.

&g 8- E

{5 BigInsights Ser 2

=0
5 ¥

@ Biglnsights Servers

i
< m ] r

E_g Problems Annotation Explorer £2 -3 FE T 0

Text analytics result, Mumber of rows: 10/10 Showing page1 of 1
Input Document Left Context Span Attribute Value Right Context  *
“Facts.b ructure, and widespread land mi... Afghanistan [1397-1408] Location: Sou
“Facts.be dence was soundly defeated in1... Bermuda [17737-17744] Location: Mor
‘Facts.bd e and the world's newest democr... East Timor [28767-28777] Location: Sou
“Facts.bd flared in 1995 was resolved in 199... Ecuador [40228-40235] Location: Wes =
Facts.bet erior as a National Wildlife Refug... Howland Island [55811-55825] Location: Oce
WFacts.bd hen the islands gained independe... Palau [589676-59681] Lecation: Oce
“Facts.bet estic political and economic refor.., Taiwan [71026-71032] Location: East
“Facts.bd d Assembly were established in 1... United Kingdom [88320-88334] Location: Wes
‘Facts.bd . and rapid advances in technolo... United States [111783-111796] Location: Mor —
4 [ ] 3

type filter text

a [V] Annotations
Pl main.Countries
4 country (SPAN])

Afghanistan |
Bermuda [17]
East Timor [2|
Ecuador [402]
Howland Isla
Palau [58676-
Taiwan [7102]
United Kingd
United States.
Uruguay [133




3. [pumepbl AQL 3KCTPaKTOPOB
M3BneveHne KoopAanHaT

create view Locations as
extract regex /Geographic coordinates: {1,}((\d{1,2} \d{2} [NS]), (\d{1,3}
\d{2} [EW]))/ on D.text
return group 1 as longlat
and group 2 as longitude
and group 3 as latitude
from Document D;

PaboTa co cnoBapsmu

create dictionary MonthsDict as (
"January®, "February®, “"March®, "April®, "May", "June®, "July®, "August-,
"September®, "October®, "November®, "December*
)
create view Months as
extract
dictionary "MonthsDict*®
on D.text as month
from Document D;

PaboTa c YacTamm peun

create view Nouns as

extract part_of speech "NN" and "NNS®" with language "en”
on D.text as noun

from Document D;

PaboTa c 610kamu

create view BlockNouns as

extract blocks

with count between 2 and 3

and separation between 0 and 50 characters
on n.noun

as BlockedNouns

from Nouns n;

PaboTa c naTTepHamm

create view Countries as
extract regex /Geography {1,}([A-Z][a-z]{1,} ?[A-Z]*[a-z]*)/ on D.text
return group 1 as country

from Document D; create view CountrylLocation as
extract

pattern (<C.country>) <Token>{5,35} (<L.longlat>)
return group 1 as country

and group 2 as location

from Countries C, Locations L;

output view CountryLocation;

PaboTa c Select

create view Textnames as
select GetText(C.country) as country, GetText(C.location) as location



from CountrylLocation C;



4.Fknmwep3agaqmceHTmmeHTaanoroaHanmsa

create dictionary CountryDict as (
"Afghanistan®, "Bermuda®, "East Timor®, "Ecuador®, "Howland Island”,
"Taiwan®, "United Kingdom®", "United States®, "Uruguay”

);

create dictionary NegativeSentimentsDict as (
"reduce®, "poor®, "fall", "insufficient”

);

create dictionary PositiveSentimentsDict as (
“growth®, “efficient”, "intensive®, "good”, "positiver

);

create view Country as
extract
dictionary "CountryDict”
on D.text as country
from Document D;

create view Paragraph as
extract
split using B.boundary
retain right split point

on B.text

as text

from (

extract

D.text as text,
regex /(An\s*\n)/ on D.text as boundary
from Document D

) B

output view Paragraph;

create view EconomyOverview as

extract regex /Economy - overview:/ on D.text
return group 0 as text

from Document D;

create view EconomyOverviewParagraph as
select

P.text
from Paragraph P, EconomyOverview EO
where

Contains(P.text, EO.text)

output view EconomyOverviewParagraph;

create view CountryEconomyOverview as
select

C.country

, P.text
from EconomyOverviewParagraph P, Country C
where

Follows(C.country, P.text, 1, 10)

output view CountryEconomyOverview;

"Palau”,



create view EconomyPositive as

extract
dictionary "PositiveSentimentsDict”
on CEO.text as positive

from CountryEconomyOverview CEO;

output view EconomyPositive;

create view CountryEconomyPositive as
select
CEO.country
, EP.positive
, 1 as cnt
from CountryEconomyOverview CEO, EconomyPositive EP
where
Contains(CEO.text, EP.positive)

output view CountryEconomyPositive;

create view EconomyNegative as

extract
dictionary "NegativeSentimentsDict”
on CEO.text as negative

from CountryEconomyOverview CEO;

output view EconomyNegative;

create view CountryEconomyNegative as
select
CEO.country
, EN._negative
, -1 as cnt
from CountryEconomyOverview CEO, EconomyNegative EN
where
Contains(CEO.text, EN.negative)

output view CountryEconomyNegative;

create view CountrySentiment as

(select
CEP.country
, CEP.cnt
from CountryEconomyPositive CEP)
union all
(select
CEN.country
, CEN.cnt

from CountryEconomyNegative CEN)

output view CountrySentiment;



5. PaboTta c No/1b30BaTENBCKMMM QYHKUMAMM

CoszpnaHue Java Kniacca

rﬂ New Java Package . - ‘ ) Elﬂu

e
Java Package .
Create a new Java package. g

Creates folders corresponding to packages.

Source folder:  TestSentiments/src Browse...

Mame: my_udf

@ [ Ensh |[ cCancal | ||

[ Java Class
|
Create a new Java class.

Source folder: TestSentiments,/src Browse...
Package: my_udf Browse...
Enclosing type: | | | Browse... |
i
|| Name: MyUDF'
I Meodifiers: @ public () default private protected N
abstract final [ static
| Superclass: java.lang.Object Browse... I
Interfaces: Add...
| Remove | I
Which methed stubs would you like to create?
public static void main(String[] args)
Constructors from superclass
Inherited abstract methods
Do you want to add comments? (Cenfigure templates and default value here
Generate comments
I

@ [ Fnish ][ cance |

PepfaktnpoBaHue Knacca. Co3gaHme pyHKUmmM toUpperCase
package my_udf;

import com.ibm.avatar._algebra.datamodel .*;

public class MyUDF {



public String toUpperCase(Span s) {

return s.getText().toUpperCase()

}

KomnunnmpoBaHune npoekTa 1 cosgaHue jar dparna
1) OTKOMNUANPOBaATb MPOEKT
Project -> Build Project

2) OTKpbITb KOMaHAHYIO CTPOKY C AnpekTopueit %EclipseWorkspace%\%ProjectName%\bin
3) 3anycTtuTb KOMaHAy co3aaHus jar palina:

jar —cf my_udf.jar my_udf/MyUDF.class

B Ci\Windowshsystem32wcmd.exe

D:“UserssDima“workspacesTestSentiments~bin>jar —cf ny_udf.jar my_udf  MylDF.class|®

==

m

4) CosgaTtb AQL module udf n B Hem co3aaTb nanky jar

1 Project Explorer &2 {% Package Explorer

47 :,-K TestSentiments

=), JRE System Library [jreT]

= Biglnsights ¥2.1.0.0
4 [ src
£ main
4 B3 my_udf
[J] MyUDF,java
B udf
1= BlApp
[= data
== result
4 [ textAnalytics
= bin
a Ly src
g main
a gy udf
[= jar
4 my_udf.agl

o]
L

= O
=

-~

m



5) Cospatb AQL ckpunT my_udf.aql

Project: /TestSentiments

Module name:  udf

Eﬂ MNew AQL script I. | =] |_ﬂh
AQL script ]
Use this wizard to create a new AQL script y

Browse
Browse

File name: m:,.rJ.ldf.aql

(@) Finish | |

Cancel

6) PepaktmMpoBaTb ckpunT my_udf.aql

module udf;
-— TODO: Add AQL content here

create function udfToUpperCase(pl Span)
return String

external_name "jar/my_udf.jar:my udf._MyUDF!toUpperCase*

language java
deterministic
return null on null input;

export function udfToUpperCase;

7) PepaktupoBaTb cKpunT main.aql. Jo6aBuTb B Hero cieaytollee npeacrasieHume

import function udfToUpperCase from module udf as udfToUpperCase;

create view CountrySentimentUpper as

select
udfToUpperCase(CS.country) as country
, CS.cnt

from CountrySentiment CS

output view CountrySentimentUpper;
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